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Preface

The CATIA Version 5 Circuit Board Design is a new generation product which
addresses circuit board design in a mechanical design context and interfaces with
external ECAD systems.

The CATIA - Circuit Board Design offers the following main functions:

¢e ¢ Co e

L

Data can be imported from ECAD Systems through IDF Files

Data can be exported to ECAD Systems through IDF Files

Circuit board geometry is designed within the global assembly product definition
taking into account the mechanical context

Electronic properties such as top and bottom faces can be defined and edited
on any parts and assemblies

Spatial and technological constraint areas can be created and managed

Circuit board definitions can be analyzed in the context of the full Digital
Mock-Up definition

Creation and management of electronic part catalogs are available

As a scalable product, CATIA Version 5 Circuit Board Design can be used in
cooperation with other current or future companion products of the next CATIA
generation such as CATIA Version 5 Assembly Design and ENOVIA-DMU Navigator
Version 5.

Uzing Thiz Guide More Information
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Where to Find More Information

Prior to reading this book, we recommend that you read the CATIA - Infrastructure

User's Guide.
The CATIA - Part Design User's Guide, the CATIA - Assembly Design User's Guide
and the CATIA - Sketcher Version 5 may prove useful.
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What's New?

New Creating Components
Enhanced Component Properties
New Creating a Catalog
New Query from Catalog
New Import using a Catalog

New Import in Context




Getting Started

r@" Before getting into the detailed instructions for using CATIA - Circuit Board Design Version 5, the following tutorial
= provides a step-by-step scenario demonstrating how to use key functionalities.

&P Before starting this scenario, you should be familiar with the basic commands common to all workbenches. These
' are described in the CATIA - Infrastructure User's Guide.

The main tasks proposed in this section are:

Tasks

Acceszing the Workbench
Creating the Board
Pocket and Haoles
Constraint Areas
Exporting Data

Imporing Data

Lbbbbb

¥ All together, these tasks should take about 15 minutes to complete.
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Accessing the Circuit Board Workbench
In an Assembly Context

[ . . . L
ii@' This task explains how to set up the environment to design in context.

To design in context, you need to load the CATProduct document containing the context; in this
case the bottom part of a CD player.

Q Open the CDPlayer.CATProduct document from the \online\samples\circuitboard directory.

& Make sure the Productl feature is highlighted before changing workbench.
E 1. Choose the Circuit Board Design item from the Start -> x>
- Equipments & Systems menu.

The Circuit Board Design workbench is displayed and ready to use.

%] CATIA ¥5.2 - [CDPlayer. CATProduct]
H Start  File  Edit  Miew  lnzett Toolz  Window  Help ;[ilil
o] Product]

] M umber_0 [PCEOARD_20_Mator.1]

£a] Mumber_1 [PCEOARD_21_OpenEuttan.1]

ga] Mumber_2 [PCEOARD_22_StopButton. 1)

] Mum ber_3 [FCEOARD_23 PlayPauzeButton.1]

& Mum ber_4 [PCEOARD 24 FaztRewindButton.1)

E.H Mumber_5 [PCEOARD_25_Fa wardButton, 1]

Gl N umber_E& [PCEOARD_50 EaseSupport.1]

ga] Mumber_7 [PCEOARD_12_BOTTOM.1]
—ga] Partd [Partd. 1]

Select an object or a command |

u Note that a new part Part9 has been automatically added to the specification tree. It will be used to
design the board.



i You can add the Circuit Board Design workbench to your Favorites, using the Tools ->
Customize item. For more information, refer to CATIA V5 - Infrastructure User's Guide.
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Creating a Board

This task explains how to create a board then design its geometry.

Circuit Board Design functions are available when you are in the Part Design environment.

Several functions are integrated from the Part Design workbench.

You are in the CDPlayer.CATProduct document.
The Circuit Board Design workbench is displayed.

1. Select the Board icon

2. Select the Sketcher icon @
3. Select the bottom plane of the CD box.
The Sketcher workbench is launched.

4. Click the Profile icon Q—B )

5. Sketch the contour of the Board.
The profile looks like this:

.
6. Quit the Sketcher using the Exit icon 3.
You are now in the Circuit Board Design
workbench.

For more information about the Sketcher, refer to the CATIA V5 - Sketcher User's Guide.

*'-*-l@ia” Pantd [BOARD)
o=y Pt

< wy plane

< uz plane

£ v plane

#% Paitfiody
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7. Click the Pad icon @

The Pad Definition dialog box appears. Pad Definition

Firzt Limit
Type: IDimensinn j
Length: |2mm E

Limit:  |Mo selection

[ Mirrored extent

Reverse Direction ]

8. Enter 2mm in the Length field. bl cipes |

I @ 0K ] ﬂ.fl'-.ppl_l,ll ql:ann:ell

9. Click OK.

The pad turns green, this means the board has been created.
The board has been created from the active part: Part9(BOARD)

CATIA recognizes the first pad created as the Board.

#5
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Creating a Pocket and Holes

]ﬁ‘. This task shows how to create a pocket and two holes, with technological
properties.

E 1. Sketch the contour of the pocket.
"

To do so:

@ click the
Sketcher

icon @

@ select the
board to
define the
working
plane

@ click the
Profile icon

QB and

draw the
contour
around the
motor

@ then click the
Exit Sketcher

_ T
icon B2 1o
return to the
3D world.

2. Click the Pocket icon ="
The Pocket Definition dialog box is displayed and CATIA previews a
pocket with default parameters.



3. Set the Up to last Pocket Definition BE

option to define the

pocket limit. — First Limit
This means that the Tuge: Im

o : YpE: -
application will extend the -
pocket to the last Depth: |00 =
possible face, that is the Limit:  [MNa selection
pad bottom.

[ Mirrored extent

FReverse Direction |

M ores » i
w 0K @ ASpply w Cancel

4. Click OK.

5. Click the Hole icon .

6. Select the board to define the working plane.
The Hole Definition dialog box appears.
CATIA previews the hole to be created with default parameters.

7. Enter 4mm for the diameter and click OK.
The hole is created.

8. Repeat the steps 5, 6 and 7 for the second hole.
The pocket and holes are added to the specification tree.



=l Partg

<" wy plane

— <7 vz plane

— <7 zxplane

"‘F’artEIDdy
3] Pad

@ Focket.]

2] Hale.1

‘—@ Hole.?

9. Right-click the Hole.1 in the specification tree to display the contextual menu.

10. Select Properties.
The Properties dialog box Properties
opens.

11. Click the More... button.

Current zelection : [Hale 1

Feature Properties | Circutt Board Drezign |

Subtupe| PFTH -
12. Select the Circuit Board P J

tab. HPTH

13. Switch the Subtype to NPTH (non conductive) and click OK.

@ The hole is more than a simple hole: it has a technological property.

14. Repeat the steps 9 to 13 for the second hole.
These holes are used for mounting purposes.

#7/
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Creating a Constraint Area

I--—-|
%‘ This task shows you how to create a constraint area.

A constraint area is a space reservation used for different purposes such as
allowing/forbidding the routing or placing of components etc.

Each constraint area belongs to a part, this is to say that you need to create a new part
before creating a constraint area.

- Create a new part in your CDPlayer.CATProduct document.
=&, To do so:

@ Double-click Productl in the specification tree

@ Right-click the Productl feature and select New Part in the contextual menu
@ Enter ConstArea for the Part Number and click OK

@ Click No to define the origin point of the assembly as the new part origin point.

.E 1. Select the Constraint Area icon @
™ The Constraint Areas dialog box opens. e DUTLINE

The constraint area types are: PLACE DUTLINE
@ ROUTE OUTLINE OTHER_OUTLIME
® PLACE OUTLINE LR ol
@ OTHER _OUTLINE PLACE REGION
@ VIA KEEPOUT ROUTE_KEEPOUT
@ PLACE_KEEPOUT n— j ac Ij
- drice
@ PLACE_REGION i
@ ROUTE KEEPOUT

2. Choose the PLACE_KEEPOUT type and click OK.

3. Select the Sketcher icon @

4. Select the board to define the working plane.

5. Click the Profile icon QE' and draw the contour around the CD buttons.



7. Click the Pad icon @

The Pad Definition dialog box appears.

8. Switch the type to Up to plane.

9. Select the plane on which the CD buttons
are placed to define the bottom limit of the pad
and click OK.

The PLACE_KEEPOUT area is displayed in
transparency.

Pad Definition EHE|

— First Lirnit

Type: lare
Length: IEDITIITI
Limit: | Plare.1

[ Mirrared extent

RHewverse Direction II

Maore: I

”ﬂ E. l l‘.-'—‘-.ppl_l,ll GEancell
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The pad is more than a simple pad: it has technological properties.

10. Right-click the PLACE_KEEPOUT.1 in the specification tree to display the contextual
menu.

11. Select Properties.

The Properties dialog box opens.
12. Click the More... button. Current selectian ; IF'L.-'-‘-.EE_KEEF"EILIT

techanical | Circuit Board D ezign | Froduct |

13. Select the Circuit Board tab. SublypeJFCACE_KEEPOLT

b aximnal heightlEmm

14. Enter 6mm in the Maximal height field and = Minimal height|2mm
2mm in the Minimal height field then click OK.

The pad is updated: the maximal and minimal height are linked to the pad limits.
It represents the overall dimensions of the constraint area.

#7/
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Exporting Data (as IDF)

"@" This task shows how to export data to an IDF file.

| =)

1. Click the Export icon
The Export dialog box opens.

3

2. Enter Export in the File name field.

E xport HE |
Lookjne | =3 Chd = m ek e ==l
TESTComps.idf
File name: IEHpDrt Open
Files of type:; Iiu:lf files j Caticel
[T Open as read-orly
|IDF 2.0 B -
3. Press Open.
An Information message is displayed:
=]

Information

@ our document haz been succeszzfully exported |

#3
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Importing the IDF File

=" This task shows how to import the IDF data previously saved to a new document.
== You can also import IDF data from an ECAD system.

2 You are in a new Product document.

‘m g—) Sel?Cttrl]:"e -2 File Selection EE
Zr pen in the menu _ ! -
bar. Lok in: |F_~1 Chd ﬂ | ﬁl I i

The File Selection

. AlE Lidf
dialog box opens. 9] Esport,

TESTComps.idf

2. Select .idf in
the File of type
field.
File name: I Opet
Files of type: i-:If [*.idf] j Cancel
[T Open as read-only
[T Load partially
3. Select the
Export.idf file.
4. Press Open.
@ If the file contains components, an Import dialog box opens.

5. Select the
library of interest.



6. Press Open. Import

Lok in: | =9 Chd

- = e

TEST_Components.lib

TESTComps.lib

File name:

Open

Files of type:  |library [ =lib ]

[T Open az read-only

Canicel

The result should look like this:
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Basic Tasks

The Basic Tasks section explains and illustrates how to create various kinds of
features.
The table below lists the information you will find.

Themes

Cresting & Board
Managing Components
Working swith Catalogs

Importing

wWorkbench Integration

Jbebb



Creating a Board

This section explains and illustrates different methods to create and/or modify
a board and its components.
The table below lists the information you will find.

Automatic Recognition

From Previously Crested Part ﬁ :

Cresting & Board anaging Components

g'iu:nrking with Catalogs g Importing ginrkhench Integration




From a Previously Created Part

F@' This task shows how to create a board from an existing part.
| =

Open the Scenariol.CATProduct document from the Samples/circuit board directory.
.==. It contains a part with two pads.

Froduct]

==l Fartl
7wy plane
< vz plane
<7 zx plane
"" FanBody

T-@ Pad 1

=3 pad.?
E 1. Click the Board icon F.

@ The PartBody contains two pads, so you have to select the pad which will represent the board.

2. Select Pad.1.

CATIA recognizes the board and displays it in green.
You can add holes, pockets and constraint areas, as well as technological properties.

#7
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Automatic Recognition
In Circuit Board Workbench

)|
i

This task illustrates how Circuit Board features are automatically recognized.

I

-p Open the Scenario2.CATProduct document from the Samples/circuit board directory.
=% |t contains a part with a pad, holes and a pocket.

B Product]

PF?’ Part] (Part1.1]
o it

[« wy plane

. yz plane

<z plane

‘_ﬁ FartBody

1I-v-§l Pad 1
] Haled
<l Hole.2

#=Tl Pocket]

.% 1. Click the Board icon g.
Since there is only one pad, it is recognized to be the board representation.

The objects (board and holes) have automatically acquired technological properties:



Current selechon I BEOARD

Mechanical | Froduct | Graphic | Circuit Board Design |

Top leyer[ TOP -

Current zelection ; IH:::IE.1

Feature Properties | Circuit Board D esign |

Subtype| PTH -

7]
2. Select the Export icon .
A board is recognized, all the related features are taken into account and exported
to the IDF file.
3. Open the .idf file as a text file. It looks like this:



B Scen2.idf - WordPad (O] x|
File Edit Miew Inzert Format Help

D|d| Slia s o=@l | 2

| HEADER. -

BOARD FILE 2.0 MCATIA WiR=" 5/21/99,14:59:32 1

Fartl MM

.END HEADER

.BOARD OUTLINE

S, 000000

o =100, 000000 -0, 000000 0,000000

o 30, 000000 —-30, 000000 O, 000000

o 80, 000000 =70, 000000 O, 000000

o 40, 000000 =70, 000000 0, 000000

] 40, 000000 —-&0, 000000 0, 000000

] O, 000000 —-80,000000 O, 000000

o S0, 000000 —60,000000 S0, 000000

o S0, 000000 10, 000000 0, 000000

o 7o, 000000 30, 000000 S0, a0ooaa

o =70, 000000 30, 000000 0, 000000

] =70, 000000 20,000000 0,000000

] —-90, 000000 20,000000 0,000000

o =90, 000000 30,000000 O, 000000

o -110,000000 A0, 000000 O, 000000

o =110, 000000 80, 000000 0, 000000

o =100, 000000 80, 000000 O, 000000

1 =90, 000000 0,000000 0,000000

1 =70, 000000 0, 000000 0,000000

1 =70, 000000 =50, 000000 0, 000000

1 =-90,000000 =50, 000000 0, 000000

1 =90, 000aan 0, 000000 0, 000000

.END BOARD OUTLINE

.DRILLED_HDLES

2, 000000 T 296326 12,748661 FTH EOLRD

2, 000000 T1l,151a7S —-66,700529 FTH

BEOARD .

.END DEILLED HOLES ;J
For Help. press F1 [ [NUM

#3%
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Components Management

This section explains and illustrates different methods to create, use and/or
modify components.
The table below lists the information you will find.

Component Creation
Componert Propeties
Componerts and Constraints

2uery From Catalog

bbbl

Creating & Board Managing Component:s

MY B ¢
iéiﬁ:rking weith Catalogs Impoarting giﬁ:rkhench Irteqration
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n®&w Creating a Component

This task explains how to create and manage components.

Open the Component. CATProduct document from the
\online\samples\circuitboard directory.

The window looks like this:

E Cormponent

= Compo (Compao.l)
g oo

.7 xvy plane

=7 vz plane

< zx plane
I-'— PartBody B
Ir—@ Pad.l
#—7, Sketch.1
1. Select the Component icon
i,
'(I)'ggnliew Component dialog boX | prrym—m ——— H=

Paclkage number: I]

Fart number: ||:.;.|-|-.|;..;.

@ 0K j iCancte

2. Enter compl in the Package number field.
3. Click OK to validate.

4. Select Pad.1 in the specification tree. This is the geometrical
representation of the new component.

The component is created.

#3
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n@&w Component Properties

This task explains how to browse the technological properties of a component.

A Jol

Open the Scenario3.idf file and the corresponding Scenario3.lib file from the
==, \online\samples\circuitboard directory. An Assembly Product document is
generated.

1. Select the power jack PWJK (PW.1).

'

2. Using the right mouse button, open the Properties dialog box.

3. Click the More... button then select the Circuit Board Design tab.
The component is located on the Top face and its Status is Unplaced.

4. Change the Component location to Bottom and the Status to Placed.

Properties K Ed
Current selection : IF'W T
Mechanical | Product | Graphic | Zircuit Board Design |
Status|PLACED |
Component Iu:n:atiu:unlBDttDm j
Package numbedFOWERIACE e
@ OK I @ Apply ] iCancel]
.

CATIA projects the component onto the bottom board surface (in this case).

@ You can still move the component to the desired location on the surface of the
board.



5. Change the Status to Fixed
The FixTogether Constraint is created between the board and the power jack
PW.1.

Ilb—ﬁ Constraints
—ﬁ Coincidence.1 (BOARD,PH.1)
— & Coincidence.z (BOARD,JK.1)
—ﬁ Coincidence.3 (BOARD,R1.1)
—ﬁ Coincidence. .4 (BOARD,C1.1)
— & Coincidence.5 (BOARD,ICE.1)
—ﬁ iCoincidence. 6 (BOARD,ICA.2)
— 2 FixTogether 1(BOARD, T1.1,Pw .1}

#3
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Components and Constraints

!ZE, This task explains how to manage components given the component constraint

== type.

Open the Scenario3.idf file and the corresponding Scenario3.lib file from the
,_%f \online\samples\circuitboard directory. An Assembly Product document is
generated.

P‘H Froduci
Fﬁ catia_new _board [catia_new_board. 1)
% PLACE_KEEPOUT [PLACE_KEEFOUT.1)
¥ Puik [P 1)

T—H&“ PH4 [PH.1)
K k)

8 REST1 (R11)
¥ cap2 it

T'Hi’ CHIF (ICE.1)

T'F-E CHIF [ICE.2)

T—H&” TRANS (T1.1)

=] Constraints

If the configuration you are using provides access to the Assembly workbench,
u—' geometrical constraints are created between the board and the components, and

are displayed.

Within the assembly, the board need to be anchored.

1. Double-click the
E power-jack
iy, constraint shown

here in red.




The Constraint
Edition dialog box
opens.

The constraint type Conztraint Tppe: Surface contact

is either Surface @ E; Mares> |

Contact (placed
w Cancel i

Consztraint Edition K E

component) or Fix _
Together (fixed .
component).

The Assembly constraints (geometrical constraints) linking the components to
the board depend on the component status.

Component Status Assembly Constraint
Unplaced No Constraint
Placed Plane to Plane Constraint
Fixed Fixity Constraint

This information is transmitted through the import file (.idf), the component
capability to change location is then driven by the constraint.

Under certain circumstances, a component status can be modified:

@ from unplaced to placed or fixed
@ from placed to fixed

but never from fixed to placed or unplaced, nor from placed to unplaced (in order
to keep the information defined in the ECAD world).

#3
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n®w Query From Catalog

"@" This task explains how to insert a component resulting from a catalog query, in
==, aproduct.

Open a new Product document.
- P

O

1. Click the Query from Catalog icon i :

‘4

The Catalog dialog box opens.

2. Select the catalog of interest and validate.

Catalog

Lok jr: |9 Chd

1 Samples
153

Irmport. catalog
Imports. catalog
Impork 3. catalog

File narme: Irmpart. catalog Open I

Files of type: | zatalog [ *.catalog | j Cancel |

[T Dpen az read-only

The Component chapter contents window is displayed.



Component chapter contents Hi=] E3

Juery | Reset
Parthumber

P Ik
P
REZ11
CAPE
CAaP1
ZHIP
TRAMNS

bt B = Iy I O N T N

G0 To Flu:nwl ClEen l Row: 1 aof 7

@ DK I iCancelI Help

3. Select a component, for example RES11
4. Copy it (Edit -> Copy or Ctrl+C)

5. Paste it (Edit -> Paste or Ctrl+V) in your document.
You can also display it using the Open button.

Productl

T "artl (Partl.1)

‘_@ Partl

=7 xy plane
=<5 vz plane
" 7w plane
—%3 partbody
#—M pes11 (RES11.1)

The component is now present in your Product document.

#7/
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n®&w Working With Catalogs

This section explains and illustrates different methods to create and/or modify
the board and its components.
The table below lists the information you will find.

Catalog Creation ﬁ :

Import with Catalog

Cresting & Board anaging Components

€ 2 I
{_ orking with Catalogs Importing giurkhenn:h Irtegration
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n®&w Creating a Catalog

This task explains how to create a catalog for circuit board components.

Open the Component2.CATProduct document from the
\online\samples\circuitboard directory.
The component is selected.

1. Select the Export a Component icon
i,

= . .
Th tal q 't exist This catalog doesn't exist

€ calalog doesn _eXIS » you are Do you want to create It 7
prompted to create it.

2. Click Yes. Mo
3. Enter a name for the catalog.
Catalog |
Look in: I A circuitboard j | |-=~_=~i:a| i éél
File nare: Opet
Files of type: | catalog [ * catalog ) j Cancel
[T Open az read-only

4. Validate.



A message informs you that the catalog has been created.

Information | x| |

@ Your catalog has been successfully saved |

U-—,.,- Note that you can store several components at the same time in the catalog.

g Catalog Creation Import with Catalog
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n@w Import with Catalog

This task explains how to import data, where the component 3D geometry is imported from a catalog.

1. Open the Import.idf document from the \online\samples\circuitboard directory.
The .idf file contains the location of the components in the circuit board assembly.

You can also use library and/or catalog to get a better geometry of the components:

L
@

the .lib file contains the 2D footprint geometry of the components.
the .catalog contains the 3D (exact) geometry of the components.

However, none of these files are mandatory.

You can choose between several alternatives:

@
L

open a library only: the 3D geometry is extruded from the 2D geometry
open a library and use an existing catalog:

@ the component exists in the catalog, its 3D geometry is imported from the catalog
& the component does not exist in the catalog, it is extruded from the 2D geometry and stored in the
catalog
open a library and a new catalog: the 3D geometry is extruded from the 2D geometry and stored in the
newly created catalog
open no library, but a catalog:
@ the component exists in the catalog, its 3D geometry is imported from the catalog
@ the component does not exist in the catalog, it is created with no associated geometry
open no library and no catalog, the component has no associated geometry.

2. Select the ImportComps.lib file.

3. Check the box: Using a catalog

Import

Lookin: |9 Chd

1 5amples

TlvEn

IrmpartComps. ib
Scenario. ib
TEST_Components lib
TESTComps.lib

File name: IImpn:nrtEn:nmps Open I
Files of type: IIiI:urar_l,l[".IiI:u] j Cancel |

[ Open as read-only

¥ Using a catalag

4. Click Open.

5. Select the catalog and validate.



L

p

Open

Lokin: | Chd

1 Samples
1V
. Irnport. catalog

File name: |Impcurt.u:atalu:ug

Open I

Files of twpe: Iu:atalu:ug [ *.catalog |

[ Open as read-only

j Cancel |

#%%

Cataloy Crestion Imgpart with Catalog

€ €1




n&w Importing

See also Import with Catalog

@

i )

Importing in Context

This task explains how to import circuit board elements and place them in
context.

Open the Context. CATProduct document from the \online\samples\circuitboard
directory.

1. Enter Circuit Board Design workbench.
A new part is created.

% Productl
Partl (PCBOARD 12 BOTTOM.1)
#— Part? (Partz.1)

2. Select the Import in Context icon EL'“'.

3. Select the plane where you want to place the board and components, that is
to say the CD bottom plane.
The Import *.idf file dialog box is displayed.



Import =.idf file

Loak jn: I A circuitboard

Scenanod. idf
File name: | Open I
Filez of type: | idf files i Cancel

[T Open az read-only

4. Choose Scenario3.idf file, Scenario3.lib file and click Open.
The result should look like this:




|5 g |5 Cresting & Board |ﬂanaging Components
|g'i|:|rking with Catalogs {_F_ Importing |ginrkbenc:h Irtegration
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Workbench Integration

This section explains and illustrates how to integrate other workbenches
The table below lists the information you will find.

Szzembly ﬁ _

Dkl Space Analysiz

g g Creating & Board ﬁ naging Components
%‘i rking wwith Catalogs mp:u:urtlng {f Wiorkbench Integration




Assembly

The integration with the Assembly Design workbench lets you to move
components on the board, provided you are allowed to do so by the
related constraint, in the context of the full digital product definition.

Refer to the Component Management section for more information.

E g { Azzembly E DU Space Analysiz



ENOVIA-DMU Space An

An Assembly Product document is generated.
Then add the existing component (BOTTOM).

alysis

F@" The strong integration with ENOVIA-DMU V5 Space Analysis allows you to complete the analysis of the
== electronic assembly in the context of the full digital product definition.

@, Open the Scenario3.idf file and the corresponding Scenario3.lib file from the \online\samples\circuitboard
i directory.

»

=

1. Choose the DMU Space Analysis item from the Start menu.

/7

2. Perform a Check Clash using this icon %

Check Clazh

— Definition

Name:|lnterference.1

Tope: I Clazh

j |Elmm

I Between bwo zelections

H

Selection 1:[1 product

Selection 2:[1 product

— Results

%E Mumber of interferences: 1 [Clazh:1, Contact:0, Clearance: ]

Filker lizt: I.-’-'-.II tupes j I Ma filker an value

Lisk g it | List by Product |

d I.-'l'-.II shatuzes

= _Applyfiters |

M. | Product 1 | Product 2 | Type | Y alue | Status | C
1 PH.1 PCEOARD_12 BOTTOM.A  Clash Mat inspect. .
4] | 33
More > I
@ 0Ok I & Apply I L) Ear‘u:ell
-

The Preview window shows the clash:



Preview E |

The analysis reveals a clash. You can:

@ either, change the location of the component respecting the geometrical constraints
@ or create a mechanical constraint area taking the clash into account; then transmit the information to the
ECAD system in order to integrate it into the placing/routing algorithm.

@ For more information about DMU Space Analysis capabilities, refer to ENOVIA-DMU Space Analysis User's
Guide.

#7

A zzembly DML Space Analysis
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Workbench Description

The CATIA - Circuit Board Design Version 5 application window looks like this:
Click the hotspots to display the related documentation.

@RS A0 B MBS RASRERE  SSala

L @ sl 55 & oo ]

Menu Bar

Toolbar



Menu Bar

The Menu Bar and items which are available in CATIA - Circuit Board Design
workbench are the standard ones. The different commands and tools are
described in CATIA - Infrastructure Version 5.

For more information, refer to the CATIA Menu Bar section.

E p { Menu Bar E Toolbar
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Circuit Board Toolbar

This section describes the various icons available in the Circuit Board Design
workbench.

The toolbar is located on the right in the default set-up.

Circuit Board Dezign

A 1=

AT W] -

- See Creating a Board

@ See Creating a Constraint Area

See Exporting Data in an IDF File
[=% See Import in Context

@ See Sketching a Profile

@See Creating a Pad

See Creating a Pocket

See Creating a Hole
[ See Query from Catalog

- See Creating a Component

FE See Creating a Catalog

p Menu Bar Toolbar

| - € i
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board
BOTTOM

component

component
status

constraint area

cutout

drilled hole

ECAD

fixed

IDF

Glossary
B

A pad with technological properties
The technological property of a board face which makes it the
copper plated face

An electronic part defined in the electronic schematic and stored in
the ECAD component library

Describes the position of a component on a board:

unplaced: there is no constraint between the component and the
board

placed: there is a surface contact between the component and the
board

fixed: there is a fixity constraint between the component and the
board

Dedicated geometrical constraints are also associated with
components and determine whether or not you can move them.

A space reservation used for different purposes such as
allowing/forbidding the routing or placing of components etc.

Each constraint area belongs to a part, this is to say that you need
to create a new part before creating a constraint area.

A hole or a pocket on a board

D

A hole used to mount a board in its case

E

Electrical Computer Aided Design

-

See component status

Intermediate Data Format



NPTH

other outline

placed
place keepout

place outline
place region
PTH

route keepout
route outline

status

TOP

unplaced

via keepout

N

Non plated: technological property of a hole which is not conductive
(mounting hole)

Other area type defined by an outline, cutouts and a thickness

P

See component status

A mechanical space reservation where the component height is
limited

An area where you are allowed to place components

An area where placing is limited to component of certain types
Plated: technological property of a hole which is conductive

R

An area where routing of electrical connections is forbidden
An area where routing of electrical connections is allowed

S

See component status

T

The technological property of a board face which means it is not the
copper plated face

See component status

V

An area where placing via is forbidden



